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Legal Notices
Warranty
The only warranties for HP products and services are set forth in the express warranty statements
accompanying such products and services. Nothing herein should be construed as constituting an
additional warranty. HP shall not be liable for technical or editorial errors or omissions contained
herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend
Confidential computer software. Valid license from HP required for possession, use or copying.
Consistent with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software
Documentation, and Technical Data for Commercial Items are licensed to the U.S. Government
under vendor's standard commercial license.

Copyright Notice
©Copyright 1993-2013 Hewlett-Packard Development Company, L.P.

Trademark Notices
Adobe™ is a trademark of Adobe Systems Incorporated.

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.

Oracle and Java are registered trademarks of Oracle and/or its affiliates.

UNIX® is a registered trademark of The Open Group.

Documentation Updates
The title page of this document contains the following identifying information:

l Software Version number, which indicates the software version.
l Document Release Date, which changes each time the document is updated.
l Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a document, go
to:

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport ID,
go to:

http://h20229.www2.hp.com/passport-registration.html

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support
service. Contact your HP sales representative for details.

Support
Visit the HP Software Support Online web site at:

http://www.hp.com/go/hpsoftwaresupport
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This web site provides contact information and details about the products, services, and support that
HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and efficient
way to access interactive technical support tools needed to manage your business. As a valued
support customer, you can benefit by using the support web site to:

l Search for knowledge documents of interest
l Submit and track support cases and enhancement requests
l Download software patches
l Manage support contracts
l Look up HP support contacts
l Review information about available services
l Enter into discussions with other software customers
l Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also
require a support contract. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp

Disclaimer for PDF Version of Online Help
This document is a PDF version of the online help. This PDF file is provided so you can easily print
multiple topics from the help information or read the online help in PDF format.

Note: Some topics do not convert properly to PDF, causing format problems. Some elements of
online help are completely removed from the PDF version. Those problem topics can be successfully
printed from within the online help.
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HP LoadRunner 11.50 and Service Pack 11.51
Publication date:December 2012

This Readme document provides information about LoadRunner versions 11.50 and LoadRunner
Service Pack 11.51.

l What's New in LoadRunner Service Pack 11.51
l What's New in LoadRunner 11.50
l Installation and Configuration Information for LoadRunner 11.50
l Product Compatibility
l Pre-Installation_Notes_and_Limitations
l Notes and Limitations
l LoadRunner Service Pack 11.51 Notes and Limitations
l Protocol_Support_Matrix
l HP_Software_Support
l Legal_Notices
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What's New in LoadRunner Service Pack 11.51
Improved VuGen
VuGen has been further improved and enhanced to provide a more reliable, flexible and customizable
user experience.

Enhancements include:

l Snapshots - A new compare snapshot feature that enables you to split the snapshot pane and view
and compare the record snapshot with the replay snapshot.

l An improved Summary Report - That now includes detailed information from all iterations.

l Design Studio – Improved correlation functionality including:

l A discard to correlation feature that enables you to delete the selected dynamic values from the
correlation grid when a dynamic value has a status of new.

l Design Studio supports correlation for the RTMP/T protocol.

l Conditional Breakpoints – Enhanced conditional breakpoints functionality.

l Thumbnail Explorer and Thumbnails - The new Thumbnail and Thumbnail Explorer features
enable you to follow the recorded business process in a visual manner. The Thumbnail Explorer
feature enables you to navigate to a location in the editor based on a visual representation of a
step. You can also navigate in the Editor and view the corresponding visual content of the step in
the Thumbnail Explorer.

Ajax TruClient
Ajax TruClient has been significantly enhanced as follows:

l Ajax TruClient for IE Client – The Ajax TruClient for IE now supports a wealth of new features in-
line with the support previously provided for the Ajax TruClient for FF client. For example, function
libraries and event handlers.

l Ajax TruClient now has an improved and more user friendly user interface.

l Additional JavaScript APIs have been provided.

l TruClient Engine - The engine has enhanced performance, and improved heuristics have been
implemented.

l A new replace with parameter feature has been added.

l Ajax TruClient documentation is nowmore intuitive and feature specific.

Improved Correlations
Correlation capabilities have been improved with the following:

l An argument has been added to the web_reg_save_param_xpath API that instructs the query to
return the entire content of the selected node, and not just its value.

l The web_reg_save_param_regexp API now allows you to enter multiple capture groups in the
regular expression and specify which capture group to save.You can also now save the entire
matched expression.

l New out-of-box correlation rules for ASP.NET.
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l You can now change the boundaries/regular expression/Xpath before correlating.

l Correlation studio can now also correlate the RequestUrl argument

Administrator Right Restrictions
Virtual User Generator (VuGen) and Analysis can now be run without Administrator privileges.

Expanded Data Format Extension Enhancements (DFE) Support

DFE support for the following has been added:

l Binary XML DFE that transformsMicrosoft WCF binary XML into XML format.

l Remedy DFE that transforms Remedy request data into XML format

l XSS DFE that enables you to test sites that use Cross Site Scripting (XSS) defense code.

Enhanced Web HTTP/HTML Protocol Support
WebHTTP/HTML protocol has been enhanced as follows:

l A new web_set_pac API that enables you to change the PAC setting from within the script.

l The web_set_user API has been enhanced. Now if an empty string ("") is passed for host:port, the
username and password in the current web_set_user call are applied to all domains unless a
different user and password has been set for the domain with another web_set_user call.

l The maximum number of concurrent connections to the server is automatically configured based
on the User-Agent string.

l JavaScript Engine – New functionality has been added that enables you to run JavaScript code in
Web HTTP/HTML scripts.

Flex Enhancements
l New support for AMF polling and long polling. This allows the recognizing and replaying of Polling

and Long Polling in flex_amf_call steps in Flex Vuser scripts.

(This is a correction to the corresponding line in the core documentation What's New).

l RTMP/T now supports automatic correlations (Studio, rules, Response based correlations).

l The flex_rtmp_receive_stream and flex_rtmp_tunneled_send APIs now allow you to specify a time
after which a script will continue to the next step.

Enriched Citrix Support
Citrix support has been expanded as follows:

l XenApp enhancements:

l The following APIs have been added - Ctrx_Logoff: Closes the current Citrix session, and Ctrx_
Get_Server_Name: Returns the Citrix server name.

l Support for XenApp 6.5 has been added.

l ICA file adjustment - Enables support engineers to tweak the ICA files received during Citrix ICA +
NFuse recording/replay without having to make changes on the Citrix Server Web Interface level.

l Support for Citrix XenDesktop has been added.

l Citrix Access Gateway support: LoadRunner supports CAG for Citrix Client version 10.200 (or less)
and Citrix Client version 13.x.
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IPv6 Support
The following IPv6 support has been added to the currently supportedmonitors and utilities:

l NDM (Network Delay Monitor)

l Webtrace

Java over HTTP (JOH) enhancement
Asymmetric java objects traffic support has been added.

Oracle NCA
Support for Oracle forms 11 has been added

Analysis
Analysis has been enhanced as follows:

l SQLite - New support for SQLite embedded database has been added. SQLite supports a load
results database of up to 32 TB.

l Color Palette - A new color palette feature has been added, enabling you to specify up to 100
colors, and to select colors that are associated with graph entities.

l Analysis Graphs - You can now add graph notes to rich reports.
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What's New in LoadRunner 11.50
Improved VuGen
The VuGen user interface has been improved and enhanced to provide a more flexible and
customizable user experience. An all new IDE makes LoadRunner scripting easier and more
productive.

Enhancements include:

l New look and feel – Flexible panes, layouts, and more
l Solution Explorer – An easier way to group multiple scripts, access script items, and perform script-

related operations.
l Snapshots – Multiple views, improved performance, snapshot synchronization, and search

functionality.
l Improved editor – Context-sensitive support, code completion support, and provides enhanced

coloring and formatting.
l Debugger – Real C language debugger.
l Search and replace – New capabilities include search in log and snapshots.
l Step navigator – The new Step Navigator replaces the tree view, providing a single view of the

script with easy filtering and search mechanisms.
l New panes – Errors, Tasks, and Bookmarks panes display all errors, messages, and tags in simple,

easy to locate views.
l Join the Community – Community integration provides easy access to conversations and threads in

the HP Software Community.

Ajax TruClient Firefox Enhancements
This ground breaking protocol has been enhanced to support the latest technologies, and includes
many usability improvements in response to customer needs.

The Ajax TruClient Firefox protocol has been improved with the following enhancements:

l Moving to Firefox 8 for improved performance.
l HTML5 support.
l Create functions to easily reuse and share code.
l Think-time recording.
l Event handlers to support asynchronous behavior.
l API for URL filtering.
l API for setting HTTP headers.
l Automatic transactions per step.

Ajax TruClient Internet Explorer
A new protocol that brings TruClient capabilities to Internet Explorer 9. This new addition to the Ajax
TruClient family expands support to Internet Explorer (IE) based applications.

Web Protocol Asynchronous Support
Support for asynchronous behavior has been added. This capability enables the recording and
replaying of Poll, Long Poll and Push communications.

Advanced Web applications contain a lot of asynchronous communication designed to keep
information current and up to date. Applications such as chat, messaging, stock tickers, and news
updates all use various asynchronousmechanisms such as Poll, Long Poll, and Push to maintain
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data. Support for these mechanisms has been added to Web (HTTP/HTML) Vuser scripts, and the
Web (HTTP/HTML) protocol layer inside Flex, and Web Services Vuser scripts. Asynchronous
communications are recognized automatically and the recorded script is updated accordingly.

Improved Correlations
A new response correlation capability has been added so correlation is easier and faster. Correlations
can now be found based on server responses during recording, in many cases eliminating the need to
replay iteratively to find dynamic values. Coupling this with the new Correlation Studio interface and
new APIs for locating dynamic values based on XPath and Regular Expressions, makes scripting
easier and faster.

Flex Enhancements
Various enhancements have been added to better support this important environment.

Flex enhancements include:

l Using Web correlation mechanisms (rules, studio, response based correlation, web correlation
APIs).

l Supporting Web requests.
l Adobe Flex platform jars bundled in the product so application jars are not needed for message

serialization.
l RTMP FMS streaming support.
l RTMPT & RTMPS support.
l GraniteDS support.

Mobile Protocols
New protocols enabling you to develop scripts for mobile applications. Traffic based analysis is used
for native applications and Ajax TruClient technology is used for browser based mobile applications.

Data Format Extension (DFE) for Google Web Toolkit (GWT)
Web protocol includes a built-in DFE to support decoding and encoding of GWT information
exchanged as part of GWT remote procedure calls. This facilitates easy correlation and
parameterization of GWT based Web applications. The DFE feature is designed to help ease scripting
of applications that exchange formatted data. By turning the formatted data into a more readable
format the script can be easily correlated and parameterized. GWT DFE is the latest addition to the
already supported formats of Base64, JSON, URLEncoding, XML, and Prefix-Postfix.

GWT support includes:

l Format the GWT RPC data into readable and correlate-able content.
l Expose more data, such as object field names.
l Enable simple parameterization.
l Solve specific correlations for GWT.

.NET4 Support
The .NET protocol now supports .NET4 framework.

.NET4 support has been added to the existing support for .NET frameworks 2-3.5.

Web Services Enhancements
TheWeb Services protocol includes new features for better security support, improved handling of
WCF, as well as additional improvements based on customer feedback.
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The Web Services protocol includes the following enhancements:

l Improved interface for security settings, including addressing versions.
l Easier certificate selection.
l Flexible definition of signature and encryption algorithms. Also includes the option to exclude time-

stamps.
l Support of custom extensions to WCF.
l Support of LoadRunner HTTP capabilities for WCF.

Integrating Virtualized Services
Integrate with HP Service Virtualization, and use simulated services, to facilitate load testing business
processes that contain services that are not readily available or too costly. As part of your performance
test, you may want to test applications that depend on other services which are a part of your business
scenario. Instead of loading actual services, you can use simulated services in your test run. The
virtualized services are a simulation of actual services. To facilitate performance testing business
processes that contain services that are not available, LoadRunner integrates with HP Service
Virtualization. Using simulated services in your test is helpful if using actual services involves an
additional cost or requires the service of an application that is under development or inaccessible at
the time when you run your performance test.

Recording 64bit Applications
Recording of 64bit applications has been added to the existing support for 64bit operating systems.
64bit applications can usually be recognized when the ‘*32’ suffix is not displayed in the Windows Task
Manager for their process. Replay is in 32bit.

IPv6 support
IPv6 based applications can be tested in addition to IPv4 based ones. Support includes IP Spoofing.
(Internal LoadRunner communication, such as Controller Load Generator, is still IPv4 based.)
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Installation and Configuration Information for LoadRunner 11.50
Prerequisite Software
Specific software needs to be installed before you can install LoadRunner. When you run the
LoadRunner installation wizard, if the prerequisite software is not already installed on your computer,
the wizard detects which software is missing and provides the option to install it.

The following prerequisite software needs to be installed:

l Microsoft Windows Installer 3.1
l .NET Framework 3.5 SP1
l Windows Imaging Component. This is a prerequisite for .NET Framework 4.0.
l .NET Framework 4
l Web Services Enhancements (WSE) 2.0 SP3 for Microsoft .NET Redistributable Runtime MSI
l Web Services Enhancements (WSE) 3.0 for Microsoft .NET Redistributable Runtime MSI
l Microsoft Core XML Services (MSXML) 6.0
l Microsoft Visual C++ 2005 SP1 Redistributable Package MFC Security Update (x86)
l Microsoft Visual C++ 2005 SP1 Redistributable Package MFC Security Update (x64)
l Microsoft Visual C++ 2008 SP1 Redistributable Package MFC Security Update (x86)
l Microsoft Visual C++ 2008 SP1 Redistributable Package MFC Security Update (x64)
l Microsoft Visual C++ 2010 SP1 Redistributable Package MFC Security Update (x86)
l Microsoft Data Access Components (MDAC) 2.8 SP1 (or later)

System Requirements for VuGen, Controller, and Analysis
The following table describes the system requirements for installing VuGen, the Controller, or
Analysis:

Processor CPU Type: Intel Core, Pentium, Xeon, AMD or compatible
Speed: 1GHz minimum. 2GHz or higher recommended

Operating System l Windows XP Professional SP3 32-bit
l Windows Server 2003 R2 Standard Edition/Enterprise Edition

SP2 32-bit
l Windows Server 2008 Standard Edition/Enterprise Edition SP2

32-bit and 64-bit
l Windows 7 SP1 32-bit and 64-bit
l Windows Server 2008 R2 SP1

Memory (RAM) Minimum: 2GB
Recommended: 4GB or higher

Screen Resolution Minimum: 1024 x 768
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Browser l Microsoft Internet Explorer 6.0 SP1 or SP2
l Microsoft Internet Explorer 7.0
l Microsoft Internet Explorer 8.0
l Microsoft Internet Explorer 9.0

Available Hard Disk
Space

Minimum: 40GB

Load Generator for Windows System Requirements
The following table describes the system requirements for installing the Load Generator on a
Windowsmachine.

Processor CPU Type: Intel Core, Pentium, Xeon, AMD or compatible
Speed: 1GHz minimum. 2GHz or higher recommended

Operating System The followingWindows operating systems are supported:
l Windows XP Professional SP3 32-Bit
l Windows Server 2003 R2 Standard Edition/Enterprise Edition SP2

32-Bit
l Windows Server 2008 Standard Edition/Enterprise Edition SP2 32-Bit

and 64-bit
l Windows 7 SP1 32-bit and 64-bit
l Windows 2008 R2 SP1

Memory (RAM) Minimum: 1GB
Note:Memory requirements depend on protocol type and system under
test and can vary greatly.

Browser l Microsoft Internet Explorer 6.0 SP1 or SP2
l Microsoft Internet Explorer 7.0
l Microsoft Internet Explorer 8.0
l Microsoft Internet Explorer 9.0

Available Hard
Disk Space

Minimum: 20GB

Load Generator for Linux System Requirements
This section describes the system requirements necessary for installing the HP Load Generator on a
Linux machine.
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Memory (RAM) 256MB minimum
Note:Memory requirements depend on protocol type and system under
test, and can vary greatly.

Available Hard
Disk Space

Minimum: 4GB

The following table describes the supported operating systems on which you can install a Linux HP
Load Generator.

OS Type OS Version Platform

RedHat Linux l Enterprise Linux
5.0

l Enterprise Linux
6.0

l CPU Type: Intel Core, Pentium, AMD or
compatible

l Speed: 1GHz minimum. 2GHz or higher
recommended

System Requirements for the MI Listener
The following table describes the system requirements for the MI Listener.

Processor l CPU Type: Intel Core, Pentium, Xeon, AMD, or compatible
l Speed: 2GHz minimum and 4GHz or higher recommended

Operating
System

l Windows XP Professional SP3 32Bit
l Windows Server 2003 R2
l Windows Server 2008 Standard Edition/Enterprise SP2 32Bit
l Windows Server 2008 Standard Edition/Enterprise SP2 64Bit
l Windows Server 2008 R2 SP1
l Windows 7 SP1
l Windows 7 SP1 64Bit

Physical Memory
(RAM)

2GB minimum

Note:Memory needs depend on the number of LoadGenerators and
Controllers connecting to theMIL.
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Product Compatibility
LoadRunner 11.50 is compatible with the following HP product versions:

l HP Quality Center version 10.00 with the latest patch.

l HP Application Lifecycle Management versions 11 SP3, and 11.50.

l HP QuickTest Professional version 11.00.

l HP Diagnostics versions 9.12, and 9.20.

l HP SiteScope versions 11.01, 11.10, 11.12, and 11.20. To obtain a free SiteScope license to work
with LoadRunner 11.50, contact the licensing team.

l HP Service Virtualization version 2.00.

In addition, LoadRunner Service Pack 11.51 is also compatible with:

l HP Unified Functional Testing version 11.50.

l HP Service Virtualization version 2.1.

l HP Application Lifecycle Management Integration Enablement pack.

l HP Service Test version 11.50 standalone.
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Pre-Installation Notes and Limitations
This section includes pre-installation notes and limitations for LoadRunner 11.50

Windows

l If you are running McAfee or Aladdin's eSafe anti-virus applications, close them before installing
LoadRunner.

l To use Windows 2003 with a HASP plug, download Aladdin's latest HASP driver.

Linux

l The LoadRunner Linux installation is based on native packages per operating system. This requires
you to be logged in as root user to run the installation.

Virtual Environment Installation

l LoadRunner supports VMware ESX versions 3.0, 3.5, 4.0, 4.1, and 5.0.
l Running Vusers on virtual machines may adversely affect performance due to the sharing of

physical resources.

Diagnostics for J2EE/.NET Requirements

A unique transaction name must be used for each scenario.

ContentCheck in Multilingual Environments

This version supports ContentCheck rules in French, German, Spanish, and Italian. The correct
language file should be installed according to the system locale.

The suitable language file can also be copied from the installation disk:

..\lrunner\MSI\setup\international\<lang>\dat\LrwiAedInstallation.xml

to the <LoadRunner>\dat directory.

Windows Firewall Considerations

In most Windows environments, Windows Firewall is turned on by default. The firewall does not allow
certain LoadRunner components to communicate with each other. The Windows firewall therefore
needs to be turned off.

Note: Turning off Windows Firewall increases the risk to your computer's security.

For each process that needs the firewall you can unblock the process by clicking the unblock button in
the popup window that indicates that the program needs it, or by manually tuning the Windows firewall
from the Exceptions tab.
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Notes and Limitations LoadRunner Service Pack 11.51, and
LoadRunner 11.50
LoadRunner Service Pack 11.51 Notes and Limitations
This section includes notes and limitations specific to LoadRunner Service Pack 11.51.
Previous LoadRunner 11.50 limitations still apply unless specified.

Citrix

Citrix Access Gateway support - LoadRunner supports Citrix Access Gateway (CAG) for Citrix Client
versions 10.200 (or lower) and Citrix Client version 13.x.

VuGen

l When you open VuGen as a non-administrator user, during the recording process you may see a
certificate pop-up warning message. The message is automatically closed and does not affect the
recording.

l VuGen scripts should not contain non-English characters in the script name, or in any part of the
path. If you create a VuGen script whose name or path comprises of some non-English characters
you may experience problems.

Workaround: Copy the script to a different folder, ensuring that the script name and path do not
contain non-English characters.

l VuGen script names should not contain the - (minus) character.

l When you open a script, load the attached correlation file in VuGen and then regenerate the script
with the correlation rule scan and "automatically apply rule" enabled, the Search for parameters in
links and form actions rule does not find values to correlate.

Ajax TruClient

l When recording a script in TruClient IE protocol, a keyboard event together with the Ctrl key is not
supported and therefore not recorded.

l After opening TruClient by clicking Develop Script, and subsequently closing it, VuGen may still
display the yellow banner of Develop mode.Workarounds: If working with a proxy, you must
specify "bypass local connections". If working with a PAC file, the PACmust specify a direct
connection for 127.0.0.1

l If you create code in C-functions.c and the code has a compilation error, when a TruClient FireFox
browser is opened, right-clicking a step may cause the browser to crash.Workaround: Fix the
compilation error in the C code to avoid this issue.

l You cannot launch a TruClient FireFox browser for Windows XP SP3, or for Windows 2003 R2
when you are logged on without administrator privileges.

Controller

If you install Service Test or Unified Functional Testing (UFT) when the magentproc.exe service is
running on the external load generator, the Controller might not be able to run Service Test or UFT
scripts on the external Load Generator.

Workaround: After installing Service Test or UFT, on the external load generator restart the
magentproc.exe service, or alternatively reboot the external load generator.

General
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l ERP CRM Offline diagnostics is deprecated.

IPv6

l IPv6 Webtrace is not supported on 6to4 outgoing network interfaces.

l IPv6 Webtrace is not supported on Windows XP andWindows 2003 operating systems.

l The Raw Socket mode for IPv6 Webtrace is not supported; therefore you cannot trace routes to
IPv6 targets by means of Raw Socket transport.

Analysis

l Load results that contain transactions with the '@' or ',' characters may conflict with existing
transactions. This is because Analysis attempts to replace those characters with the '_', and if this
results in a transaction name conflict, an error will occur.

Workaround: Avoid using the '@' and ',' characters in transaction names.

l When working with a non-English OS and with SQLite or SQL databases, you may experience
issues displaying certain types of data in Analysis reports and graphs.

Workaround: Navigate to Windows Control Panel > Regions and Language > Additional settings
and change the Decimal symbol from a comma(,) to a period(.).

Installation

If you install LoadRunner and Unified Functional Testing (UFT) on the same server and uninstall one
of them, the remaining software program may not function correctly.Workaround: Reinstall the
software program you want to use on the server.

HP Service Virtualization

l If you change HP Service Virtualization settings from the Design tab when running a controller
scenario with an HP Service Virtualization project, the settings are not applied to the HP Service
Virtualization servers.

l An HP Service Virtualization project cannot be correctly imported to a controller scenario if the HP
Service Virtualization server uses credentials for both SSL and monitors.

Workaround: Configure the HP Service Virtualization server to only use credentials for SSL.

ALM Client Installation

l For VuGen and Analysis the ALM client can be installed using a non-administrator user. The client
is automatically installed when you access the ALM server.

l For Controller the ALM client must be installed using a user with administrator privileges.

ALM Integration

The HP Application Lifecycle Management Integration Enablement pack is not compatible with
LoadRunner 11.50. If you wish to integrate LoadRunner with the HP Application Lifecycle
Management Integration Enablement pack, you must install LoadRunner Service Pack 11.51.

QTP Integration

LoadRunner 11.5x can be integrated with QTP 11 after you install the QTP_00926.exe patch on the
server where QTP 11 is installed.

Load Generator

Oracle Web App 11i protocol script cannot run on a remote Load Generator in Controller.
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Workaround: Link the 'nca_java_custom_prop_answer_table.h' file that exists in the script directory
to Extra Files in the Vugen Solution Explorer for the relevant script as follows:

1. Open the script in Vugen.
2. In the Solution Explorer tree, right-click Extra Files.
3. Select 'Add Files to Script'
4. Navigate to the directory with the script and select the 'nca_java_custom_prop_answer_table.h'

file

SAP GUI 7.30

In SAP 7.30, a business flow containing Combo Boxesmay not replay correctly and the "Could not
find combobox entry by value..." message may appear.

Uninstalling Patch 1

If you want to uninstall HP LoadRunner 11.50 Patch 1, you must provide the path to the original HP
LoadRunner 11.50 MSI installation file. For example, if you installed from a DVD, insert the DVD into
the drive and provide the path to the location of the MSI installation file.

Note: The MSI file name is a combination of the language and type of installation. For example
LoadRunner_x86.msi is the MSI for an English 32-bit installation of HP LoadRunner, and
LoadRunner_fra_x64.msi is the MSI for a French 64-bit installation of HP LoadRunner.

Documentation

Links to external websites may not function correctly when accessing them from the Analysis and
Controller help.

LoadRunner 11.50 Notes and Limitations
This section includes notes and limitations for LoadRunner 11.50

Installation

l If you have several LoadRunner components installed on one server (for example: VuGen SA,
Analysis SA), and you uninstall one of the components, after the uninstall completes you must run
repair on the remaining components.

l You can upgrade between LoadRunner version 11.00 to 11.50. If you have a pre-11.00 version of
LoadRunner, you must uninstall it and then install the 11.50 version.

Integration

You must download and install the ALM client via a browser before connecting to ALM via Controller
or Analysis.

Integration between LoadRunner 11.50 and QTP 11 is not supported on Windows 2008 and Windows
2008 R2 operating systems. (See QTP Integration above)

Mobile

Mobile Sniffer Agent. The Mobile Sniffer Agent included with LoadRunner 11.50 supports the
following operating systems:

l Windows.Windows XP, Windows 7, Windows Server 2003, Windows Server 2008.
To run the Mobile Sniffer Agent on a Windows operating system you also must installWinPcap.
WinPcap should be installed using the default settings of the installer. The following versions of
WinPcap are supported:

HP LoadRunner (Service Pack 11.51)Page 22 of 39



ReadMe
Chapter 4: HP LoadRunner 11.50 and Service Pack 11.51

Version 4.0.2. (can be installed from LoadRunnerInstallationDVD\Additional
Components\WinPcap)

Version 4.1.2. (web download)

l Mac. MacOSX 10.6.5
l Linux. Red Hat 5 Enterprise

Controller

Secure Channels

l You cannot use the Host Security Manager utility to update security settings on Linux load
generators that use rsh (remote shell) to connect to the Controller.

l You cannot use the Host Security Manager utility to change the security mode of the load
generator located over a firewall from off to on.

l When the load generator is located over a firewall, if the load generator and Controller have
different security modes, communication cannot be established.

l If the Controller machine is using secure channel communication, the MI Listener should not be
installed on the same machine as the Controller.

l If the Controller machine is using secure channel communication, it will not be able to connect to
an HP-UX load generator.

VuGen Protocols

AJAX (Click and Script)

l ActiveX objects and Java applets are only supported on Windows platforms.
l Click and script protocols do not support pop-up windows.
l When using Windows 2003 R2, Ajax Click and Script steps do not generate after recording.

Workaround: This should work if you disable Internet Explorer Enhanced Security Configuration.
It is enabled by default. (Control Panel->Administrative tools->Server manager->Configure IE
ESC).

Citrix

l Installation of the registry patch is required for the support of all version of Citrix clients over 10.x.
Additionally, you need to install Enable_Citrix_API.reg from the LoadRunner\dat folder on
VuGen or Load Generator machines if a Citrix Client will be installed after installing LoadRunner.

l Running Citrix Vusers on virtual machines may adversely affect performance due to the sharing of
physical resources.

l Citrix XenApp Desktop cannot be recorded with Citrix Web Access (formerly known as Citrix
NFuse) if Desktop View (Desktop Toolbar) is enabled.

l Citrix protocol does not support environments that include NetScaler Access Gateway.
l Recording a Citrix NFuse script on IE9 is supported from Citrix client version 12.1.0.44.
l The Load Generator cannot run Citrix scripts in service mode when the script was recorded using

Citrix Client version is 11.2 or higher.
l Load Generator cannot be used in service mode for the Citrix protocol when the Citrix XenApp

client 11.2 is used. A workaround is to use another version of Citrix client.
l To successfully record a multi protocol Citrix and Web script on XenApp5 only the SessionToken

Citrix correlation rule should be enabled. The Session_Token Citrix correlation rule should be
disabled.
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l Citrix Clients 11.2 and higher do not support the TCP/IP mode in the Citrix > Login node of the
Recording Options dialog box.

l When recording Citrix Web Access (formerly known as Citrix NFuse) applications, set the window
size to "No preference" in the Citrix XenApp web portal preferences page.

l Recording Window Size and XenApp Plugin for Hosted Applications 11. The recording
window size option does not work properly with the XenApp Plugin for Hosted Applications 11. The
size of the client window is installed, but the server screen resolution is not. This is a Citrix Client
limitation and will be fixed in future Citrix Client versions.

Workaround:When recording, set the window size equal to the local screen resolution. When
replaying/load testing, set the VuGen or Load Generator screen resolution to equal the resolution
used when the script was recorded. To verify the recorded resolution, view the Window property in
the <Script Folder>\default.cfg file.

Click and Script (All)

l Does not support VBScript
l Does not support user actions on ActiveX objects and Macromedia Flash.
l Scalability is lower than the Web HTML protocol, depending on the size and functionality of the

business process.
l Replay snapshots may differ from the actual Web page.
l Support of right-to-left languages is limited (e.g., bi-directional or reversed text may not be

processed as expected). This is defined by the default operating system translation table.
l Recording an application in a specific language (e.g., French, Japanese) must be performed on a

machine whose default locale (in Settings > Control Panel > Regional Options) is the same
language.

l The locale of the load-generator machine, including the default non-Unicode character set, must be
configured to be the same as that of the recording machine. It cannot be assumed that the Linux
default character set is the same as in Windows, even for US-English machines, and this has to be
explicitly verified. For example, the default character set on Linux, is UTF-8.

l The Recording Options dialog boxmay take a long time to open.
l Web (Click and Script) no longer supports replay of Applets and ActiveX objects. This functionality

is now part of the AJAX (Click and Script) protocol, and is only supported on a Windows platform.

Flex (RTMP/AMF) Protocol

l Flex RTMP Tunneled

If your script contains more than one Flex_RTMP_tunneled_connect step, with the same
gateway parameter, youmust insert a disconnect step for the previous Flex_RTMP_tunneled_
connect step before you connect again. For example:

Flex_rtmp_tunneled_connect("connect_step0",

"SessionId=0",

"Gateway=http://123.123.123.123:1935",

.

.

LAST);

.

.

.

Flex_rtmp_tunneled_disconnect("disconnect_step0",

"SessionId=0")
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flex_rtmp_tunneled_connect("connect_step1",

"SessionId=1",

"Gateway=http://123.123.123.123:1935",

.

.

LAST);

.

.

.

Flex_rtmp_tunneled_disconnect("disconnect_step0",

"SessionId=1")

If a subsequent Flex_rtmp_tunneled_connect command has the same gateway parameter as the
previous Flex_trtmp_tunneled_connect step and the Flex_rtmp_tunneled_disconnect step is
omitted, the script will pause indefinitely.

l GraniteDS (Data Services)

To create a script in GraniteDS, select Use GraniteDS configuration from Recording Options
> Flex > Configurations. For code generation and replay, first copy the core and relevant
application jar files to the client machine and then specify these files in the Recording Options >
Flex > Externalizable Objects node.

The core jars are:

l dom4j.jar
l granite.jar
l hibernate3.jar
l jboss-seam.jar
l granite-hibernate.jar
l servlet-api.jar
If you have modified the granite-config.xml, copy it to the <LoadRunnerInstallation>\dat
directory.

l When switching between BlazeDS and GraniteDS parsing (Recording Options > Flex >
Configuration), VuGen must be restarted.

l LoadRunner cannot serialize both GraniteDS and BlazeDS/LCDS messages in the same script.

l Flex RTMP messaging support. All limitations that apply to AMF3 parsing apply to
externalizable objects over RTMP.

l flex_rtmp_receive_stream step. If theGenerate flex_rtmp_receive_stream step option is
enabled, all transactions, comments, and rendezvous points that you add from the Recording
toolbar are added to the script after the flex_rtmp_receive_stream step in your script.

l Web diagnostics does not work for RTMP and RTMPT steps (even when the breakdown is
enabled).

l Manually Adjusting Recorded Flex RTMP Steps

When theGenerate flex_rtmp_receive_stream step option is cleared in the Flex:RTMP pane of
the Recording Options dialog box, LoadRunner generates flex_rtmp_receive and flex_rtmp_
send steps for every communication with the server. This ensures that user actions such as pause
and seek, as well as automatic requests that the client performs when Dynamic Stream is in use,
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are included in the script, but this method also captures less-necessary lines of code that are
difficult to read and may not be reliable during replay.

If you choose to clear theGenerate flex_rtmp_receive_stream step option in order to capture
user data, follow the instructions below to remove the unnecessary steps from your script.

a. Search for the flex_rtmp_send step containing the initial play argument. For example:
flex_rtmp_send("send_step2",

        "ConnectionID=10",

        "Snapshot=tRTMP6.inf",

        MESSAGE,

        ...

        ...

        MESSAGE,

        ...

        ...

        "Argument=<arguments><string>play</string><number>0</number><null/>"

        ...

        LAST);

b. Delete or comment out the flex_rtmp_receive steps that occur during streaming. For
example:
//this is the start of the stream:

// flex_rtmp_receive("recv_step2",

// "ConnectionID=10",

// "Snapshot=tRTMP7.inf",

// CHANNEL,

// "ChunkStreamID=2",

// CHANNEL,

// "ChunkStreamID=2",

// CHANNEL,

// "ChunkStreamID=4",

// CHANNEL,

// "ChunkStreamID=2",

// LAST);

//

// flex_rtmp_receive("recv_step3",

// "ConnectionID=10",

// "Snapshot=tRTMP8.inf",

HP LoadRunner (Service Pack 11.51)Page 26 of 39



ReadMe
Chapter 4: HP LoadRunner 11.50 and Service Pack 11.51

// CHANNEL,

// "ChunkStreamID=5",

// CHANNEL,

// ...

// ...

c. You can also remove certain flex_rtmp_send steps that are not related to user actions, such
as "user control message" types. For example:
// flex_rtmp_send("send_step3",

// "ConnectionID=10",

// "Snapshot=tRTMP9.inf",

// MESSAGE,

// "DataType=user control message",

// "EventType=set buffer length",

// "MessageStreamID=1",

// "BufferLength=100",

// LAST);

d. When you find a flex_rtmp_send step that represents a user action that you want to keep in
your script, do the following:
i. Manually add a flex_rtmp_receive_stream step before the send step.
l Make sure that theConnectionID argument has the same value as the steps you

removed above it.
l The Snapshot argument is not relevant for the manually added step.
l You can use the ContinueToNexStepAfter = <msec> argument to control the

minimum play duration of the stream to download before continuing to the next step.
ii. Determine the flex_rtmp_send steps that represent the user actions you want to keep.

These will likely include arguments such as pauseRaw, pause, seek and play2 (for
Dynamic Stream). For example:

    flex_rtmp_send("send_step5",

        "ConnectionID=10",

        "Snapshot=tRTMP62.inf",

        MESSAGE,

        "DataType=command message amf3",

        "ChunkStreamID=8",

        "MessageStreamID=1",

        "Argument=<arguments><string>pauseRaw</string><number>0</number><null/>"

        "<boolean>true</boolean><number>12000</number></arguments>",

        LAST);
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iii. Determine whether there are some extra flex_rtmp_send steps that you can remove. For
example, if you dragged a button to seek in the stream, subtle jerks in the motion may be
recorded as separate pause and seek actions. In these cases, may not need all of them.
Keep only those that describe the desired operations.

iv. Identify the flex_rtmp_receive step that indicates that the server has received the end of
the user action. For example:

//this is the confirmation from the server on the "seek" command.

flex_rtmp_receive("recv_step55",

        "ConnectionID=10",

        "Snapshot=tRTMP68.inf",

        CHANNEL,

        "ChunkStreamID=2",

        CHANNEL,

        "ChunkStreamID=2",

        LAST);

e. Repeat steps 2 - 4 for each set of unnecessary receive data and required user actions in your
script.

Java (All)

l Java Record Replay Protocol: Recording of JMS applications requires JDK version 1.6u32 or lower.
l Java over HTTP Protocol: Requires the JDK version 1.5 or higher.
l When recording on Internet Explorer 8 using the Java protocol, you must first close all instances of

Internet Explorer before LoadRunner opens an Explorer instance for the record session.

Listing Directory Service (LDAP)

l If an LDAP version 3 script fails during replay, modify themldpa_logon_ex statement to specify
the version number by adding "Version=3" after "URL=.."

l When recording LDAP scripts, the binary parameter values for certain LDAP functions (such as
mldap_add ormldap_modify) are not recorded. Recording of binary parameters is part of the
protocol's extended functionality and is not supported by VuGen.

Media Player (MMS)

Media Player scripts fail with the error: Error -86801:Host access denied, <hostname> not available
or missing.

Workaround: Call themms_disable_host_check function in all Media Player scripts.

Microsoft .NET

l Applications that use the .NET Remoting Framework and are executed in CLR 2 (.NET frameworks
2/3/3.5), might crash during recording. During a crash you will receive a message containing the
strings Version=4.x.x.x, and “is not registered for activation”.

Potential Workaround: In the Microsoft .NET: Recording user interface under Support for
previous.NET version, select “Emulate previous .NET versions in transport level”, and then record
again.
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l When the application under test retrieves a server-activated object by calling new RemoteObject
(), VuGen generates aRemotingServices.Connect function.

l Applications using multiple processes or multiple application domains are only partially supported.
l Shared DLLsmust be specified in the Recording Options only. Changesmade in the Run-Time

Settings to the list of shared DLLs have no effect.

Microsoft Remote Desktop Protocol (RDP)

l Clipboard sharing supports only short simple textual content.
l When recording with RDP Agent, applications which were developed using CBuilder may not

record properly.
l Recording on RDP client versions 6.0, 6.1, or 7.0 will fail if the remote machine is running Windows

Server 2008 with terminal services.

Workaround:

l When recording a script on a remote machine running Windows Server 2008 with terminal
services, use RDP client versions 5.1 or 5.2.
or

l When recording a script on a remote machine running Windows Server 2008 with RDP versions
6.0, 6.1, or 7.0, remove terminal services.

l RDP does not support 32 bit color depth. If recording uses this color depth, VuGen automatically
switches to a lower color depth and a "[RDP Analyzer Warning ( 790: 418)] 32 bit color depth is not
supported, switch to lower one" . warning log item appears in the Recording Window.

Silverlight

l REST services do not generate Silverlight service calls. However they can be recorded and
replayed.

l You cannot edit the WSDL location in the Protocol and Security Scenario dialog box.
l The Update button in the Silverlight Service node of the Recording Options dialog box updates the

service if the WSDL location has not changed.

If the WSDL location has changed, the service is re-imported (delete service and import service).

l Duplex (Polling) Binding for WCF Web Services is not supported.
l Silverlight 4 and 5 clients are supported, however applications developed using the new

communication features such as net.tcp binding are not supported.
l VuGen snapshot viewer does not support Silverlight controls.
l The Silverlight Protocol does not support applications which use Japanese, Korean, Simplified

Chinese, and Traditional Chinese.

TruClient

l TruClient protocol versions. If you edit a TruClient script using a later version of LoadRunner
than the one on which you recorded the script, it may fail to replay in some cases.

Before modifying the script, save a backup copy of the script.Workaround: If the replay fails, re-
record the script using the latest version of the TruClient protocol.

l TruClient. Firefox Security Warning dialog boxes are not displayed in TruClient during script
development.

l The Ajax TruClient for FF protocol can only be used with applications that support the Mozilla
Firefox browser.

l The Ajax TruClient for IE requires that IE9 is installed on the server.
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l TruClient for will not record "mouse overs" when the element has a CSS rule of "Mouse Hover".

Workaround: Instead of mouse hovering, click the elements to open the drop down (the clicks are
recorded).

l TruClient protocol step types and arguments are not localized.
l Ajax TruClient for IE does not support IP spoofing.
l Ajax TruClient for IE does not support modem speed.
l TruClient General Strings are not localized in the Japanese version.
l Only scripts from version LoadRunner 11 patch 2 or above can be opened in LoadRunner 11.50

version of VuGen.
l TruClient FF does not support Kerberos authentication. If the server also supports NTLM,

TruClient FF will automatically move the authentication to NTLM and continue working.
l When you viewWeb page component breakdown graphs for TruClient Vusers, and some third-

party components such asMozilla's Necko are installed, Ajax TruClient measurements might not
be available or might be less accurate than those of other protocols. For example the Time to First
Buffer Breakdown graph, and measurements such as SSL Handshake, Client/Error Time might not
be available.

Web Services

l For large SOAP envelopes, Record and Replay snapshots are disabled.
l The Import SOAP feature is not supported for envelopes containing a single element larger than

500KB.
l Recording requests with attachments or security is not supported.
l For Axis toolkit, Web service calls that include both attachments and security are not supported.
l For .NET toolkit, SOAP version 1.2 is not supported for asynchronous calls.
l You can enter text strings up to 10 KB to encode to base 64. If your string is larger, use theGet

from file option.
l VuGen supportsWeb Service messages over JMS message Queue, but does not support JMS

Topics.
l JMS Bindings Extensions are not supported.
l All services in your script should have the same security scenario. This can be configured via the

Protocols and Security tab.
l AsynchronousWeb Service calls and custom user handlers are not supported for WCF.
l LoadRunner cannot replay scripts containing the soa_xml_validate function.
l When using "update service", steps that are already in the script will not display the updated

properties (in the step argument view) until you close and reopen the app. After you reopen the
app, step arguments are updated.

If the script is open when performing "update service", then on the script view arguments, the app
throws an exception.Workaround: Close the script file while running "update service", or reopen
the test after running "update service".

l A Web Service script might not open when you import the WDSL with the Axis toolkit.
Workaround: Import the WDSL with the .Net toolkit.

If there is a problem recreating the scripts, do the following:

1) Create a new test.

2) Import the WSDL using .net toolkit.
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3) Go to the directory of the new script.

4) Copy the folder "WSDL" and paste it on the directory of the old script.

5) In the directory of the old script open the 'default.cfg' file

6) Under [WebServices] header, instead of "Toolkit=Axis" write "Toolkit=.Net"

l When you import a WSDL file into a Web Services script whose name contains non-English
characters, if there are errors in the file, the error report is empty.

Workaround: Rename and save the script using only English characters.

Protocol SDK:

l Supports 32-bit and 64-bit OS MSIs for LoadRunner, VuGen and PC-Host only.
l Supports only 32-bit OS MSIs for PC-Server.
l For LoadRunner, VuGen, and PC-Host, PatchAddin support is for TARGETDIR files only.

SAP (Click and Script)

l You cannot define transactions to measure time of a subset of steps performed in a modal dialog.
l During recording, if a user double-clicks on a tree-view tree cell outside of its text, VuGen records

"Select" instead of "Activate." This results in a missing POST in replay.
l If the list of retrieved values contains a scroll bar, you cannot select an item that requires scrolling in

order to retrieve from the server.
l Scalability is lower than the SAP Web protocol, depending on the size and functionality of the

business process.
l Does not support theReplace with Alternate Navigation run-time setting.
l In certain SAP environments (such as 6.20 and 6.40), the replay fails for tests that call theweb_

element function and select an element whose tag name is "TD".

WAN Emulation

l There is no backward compatibility between the current LoadRunner/WAN Emulation integration
and any previous integrations.

l The integrated 3rd party software may not comply with accepted Internationalization (I18N)
conventions.

l Selecting either Use bandwidth, or Use custom bandwidth in the Network: Speed Simulation node
in the Run Time Settings, may interfere with the WAN Emulation settings and could lead to
unexpected behavior.

l WAN Emulation is disabled if the host used as the Load Generator is also used as the Controller.
l WAN Emulation is not supported if the load generator is running on a Linux platform.

Web (HTTP/HTML)

In previous versions of LoadRunner, the C type "char" is considered as "signed char". In LoadRunner
11.50 and up it is considered as "unsigned char". This means that if the user used "char" without
specifying whether it is signed or unsigned, and performed arithmetic operations on this variable, then
the results may be different when comparing LoadRunner 11.50 to old LoadRunner versions.

Web Click and Script

When using Windows 2003 R2, Web click and script steps do not generate after recording.

Workaround: This should work if you disable Internet Explorer Enhanced Security Configuration. It is
enabled by default. (Control Panel->Administrative tools->Server manager->Configure IE ESC).
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Protocol Support Matrix

Support Matrix

Protocol Async
supported

IPv6
supported

64-bit recording
supported

AMF X

Citrix Nfuse X

DNS X

Flex X X

FTP X

IMAP X

JavaOver HTTP X X

LDAP X

Microsoft .Net X

Mobile HTTP X

Mobile TruClient X

Multi Winsock X X

Oracle (2-Tier) X

Oracle NCA X X

POP3 X

RDP X X

RTMP

SAP –Web X

Siebel Web X

Silverlight X

SMTP X

TruClient FireFox X

TruClient Internet Explorer X

Click and Script family X
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Web (HTTP/HTML) X X X

Web Services X X X

Protocol Support Limitations

Async

In all the protocols that support it, asynchronous recording will only be applied to web_* steps.

IPv6

Support for IPv6 is available for the protocols shown in the table above. The support for Web HTTP
protocol has the following limitations:

l FTP from Web is not supported
l Web Breakdown is not supported
l Kerberos is not supported
l Spoofing from Web is not supported
l PAC file is not supported
l An explicit IP (in IPv6 format) in a URL argument cannot be used. For example, the following step

will fail in replay:

web_url("IPv6",

"URL=http://[2001:0db8:85a3:0000::8a2e:0370:7334]/",

"Resource=0",

"RecContentType=text/html",

"Referer=",

"Snapshot=t1.inf",

"Mode=HTML",

LAST);

64-bit recording

The environment for 64-bit recording must be as follows:

l Windows 7 x64
l New VuGen x32
l AUT x64
l Script is Multi-protocol

In general 64-bit applications ported from a 32-bit client version should work identically to the 32-bit
client.

However, there is a small risk that new clients will use the power of native 64-bit apps. For example,
when using 64-bit long types for Identifiers in DB tables, the identifier value will be cut and the query
will fail.

There are also specific limitations/requirements for some of the protocols, as described in the table
below:
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Protocol Limitation

JavaOver HTTP JVM 32-bit must be installed for Replay to work.

Microsoft .Net There are two available 64-bit types for .Net apps (AnyCPU and pure 64-bit).
LoadRunner only supports AnyCPU. There is currently no solution for pure
64-bit apps.

For Replay, LoadRunner uses the same AnyCPU dlls that were used for
Recording.

Note: With LoadRunner 11.50 .Net Framework 4 should be installed. This
package carries both versions of the libraries for 32 and 64 bit systems.

Oracle (2-Tier) Both 32-bit and 64-bit clients need to be installed (the 32-bit client is for
Replay needs).

VuGen

l SAP (Click and Script) recording. During recording, if you use a keyboard option instead of a UI
element (for example, pressing ENTER instead of clicking the log on button), the step may not be
recorded. In general, when recording your script, it is recommended to use UI elements rather than
keyboard options.

l Citrix snapshots. Black snapshots may appear during record or replay when using Citrix
Presentation Server 4.0 or 4.5 (before Rollup Pack 3).

Possible workaround:On the Citrix server select Start Menu > Settings > Control Panel >
Administrative Tools > Terminal Services Configuration > Server Settings > Licensing
and toggle the Per User/Per Device.

l For the following protocols, replay is supported, but recording is no longer supported: Siebel DB2,
Siebel MSSQL, Siebel Oracle, and Voice XML.

l In Test Result reports, you can only use the Export to HTML file utility for scripts replayed in
version 9.50 and later. To generate an HTML report for scripts created with earlier versions, run the
script again in the 9.50 version (or later) of the product.

l If you terminated the Protocol Advisor immediately after the detection process started, the
Protocol Advisor may leave a hung process of the detected application, causing all recordings and
detection sessions that follow to fail.

Workaround: Manually terminate the hung process.

l The newWeb snapshot model is backward compatible with previous versions of LoadRunner,
however some snapshot data may be missing. If this occurs, regenerate the script.

l The JSON Data Format Extension does not work in Linux environments.
l For protocols using XML, replay fails to create a request when a parameterized input argument

contains the ampersand (&) character.
l Replay of COM script in VuGen fails when the dll registration is missing the "ThreadingModel"

string under the InprocServer32 folder of the GUID.
l You cannot open a script if its full file path contains non-English characters.
l When replaying a script recorded on the HP WebTours application, set the run-time settings to

work with no proxy.
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l If you open an HP site in the embedded browser and the site is not included in the trusted sites list,
you will be prompted to add the site to the trusted sites list and after adding the site will receive a
script error.

General

l To run LoadRunner on Windows 7 or Window Server 2008, you must have Administrator privileges
and User Account Control (UAC) must be disabled.

l It is not recommended to install and uninstall a Load Generator standalone installation on the
same machine with a VuGen standalone installation.

l The Load Generator cannot run Citrix scripts in service mode when the script was recorded using
Citrix Client version 11.2 or higher.

l The Agent icon does not appear in Windows 2008 when the LoadRunner Agent service is
launched.

l When LoadRunner Agent runs as service (magentservice.exe), files that are stored on remote
network drives or referred to by UNC path cannot be accessed (script, parameter file, etc.). If you
want to access files this way, run the LoadRunner Agent as process (magentproc.exe). If this is not
possible, please contact Customer Support.

l The RealPlayer protocol is deprecated as of LoadRunner 11.50. In the next version, it will be
discontinued.

l TheWAP protocol is deprecated as of LoadRunner 11.50. In the next version, it will be
discontinued.

l On the LoadRunner server, Internet Explorer Enhanced Security Configuration must be disabled to
view help content. It is enabled by default. (Control Panel->Administrative tools->Server manager-
>Configure IE ESC).

l HP Service Test 11.2 cannot be installed on top of a LoadRunner 11.50 installation.

Workaround: Install Service Test 11.2 first then LoadRunner 11.50

l In LoadRunner 11.50 Correlation (RBC, Rule and Comparison) support for Siebel protocol is
disabled.

l When using Windows 2008 R2 and opening a snapshot from the step navigator in SAP GUI and
Web protocols, the snapshots might not open automatically.Workaround: Internet Explorer
Enhanced Security Configuration must be disabled to view help content. It is enabled by default.
(Control Panel->Administrative tools->Server manager->Configure IE ESC).

l Recording on 64-bit O/S’s for 32-bit, and for 64-bit apps (running as a 64-bit application) is
supported. Replay is only at 32-bit. See the support matrix and limitations above for more
information.

l Firefox. If Firefox is set as the default browser, Obtain the proxy settings from the default
browser (Run-time Settings > Internet Protocol > Proxy) does not work, and a direct
connection is used.

l Data Format Extensions. A script that includes a DFE can only run on a load generator hosted
on a Windows platform.

l If you have implemented your own version of DFE, the definition of class HTTPEntity in
DfeDefinitions.h file has been updated in LoadRunner 11.50. All customer's DFE extensions need
be recompiled. (NO code change is required).

l For Single WinSock scripts from LoadRunner 11, the recording log is not displayed in VuGen
11.50.

l If you are using a PAC file for proxy configuration, it is required that the PAC script directs
127.0.0.1 to a direct connection and not through a proxy.

GUI Vusers
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l LoadRunner supports GUI Vuser scripts created using HP QuickTest. GUI Vuser scripts created in
WinRunner are no longer supported.

l Windows Load Generator machines can only run one GUI Vuser at a time. To run multiple GUI
Vusers in a load test, you need to open a terminal server session for each GUI Vuser. For more
information, see the HP LoadRunner Controller User Guide.

SiteScope

l If you are configuring the SiteScope System Resources Graph (System Resources Graphs >
SiteScope), you cannot specify a specific SiteScope user account. LoadRunner uses the default
SiteScope Administrator user.

l If you want to configure SiteScope monitoring with a SiteScope account other than the default
SiteScope Administrator account, you need to explicitly assign a group with monitors to that
account in SiteScope.

Analysis

l Analysis currently supports Microsoft SQL Server versions 2005 and above.
l If you are using Microsoft SQL Server 2000, you need to either migrate Analysis data, or upgrade

to Microsoft SQL Server 2005. The following tasks describe how to perform the migrating and
upgrading procedures:

To migrate legacy Analysis data to a SQL 2005 server:

a. From the SQL Server Management Studio, using Object Explorer, connect to an instance of
SQL Server Database Engine.

b. Expand Databases, right-click Analysis database, select Tasks\Copy Database.
c. Follow the instructions in the wizard.

To upgrade SQL 2000 to SQL 2005:

d. Backup Analysis database on the SQL 2000 (http://msdn.microsoft.com/en-
us/library/cc966495.aspx)

e. Uninstall SQL 2000.
f. Install SQL 2005.
g. Restore Analysis data from backup. (http://msdn.microsoft.com/en-us/library/ms177429

(SQL.90).aspx)
l If you are using your own policy in an MS SQL server, you may need to add your own account to

the Analysis database template (in the <LR Installation>\bin\dat folder).
l When exporting Analysis reports to MS Word, take into account that the content load may affect

the table format within the document. The RTF format is recommended.
l The following Analysis default settings have been modified: Include Think Time is disabled and

Display summary while generating complete data is enabled.
l There is a limitation with MS Access and SQL queries when filtering a large number of

transactions (greater than 100).
l Even after running the <Language> User Interface Pack, the Analysis UI data generated from the

sample session (in the <LR Installation>\tutorial folder) will display in English. Filtering the
graphs will fail.Workaround: Re-generate the graphs and then the corresponding language from
the <Language> User Interface Pack will display and filtering will work.

Multilingual Support

Language Packs

l LoadRunner User Interface Pack.While installing the Language Pack a warning message may
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be displayed that the HP LoadRunner Launcher Process is in use.
Workaround:ClickContinue to continue the installation.

l The language pack of .Net Framework needs to be installed to show the localized strings.

l Tutorial scripts. After the Language Pack installation, all sessions and scripts in
\HP\LoadRunner\tutorial are still in English.

l LoadRunner User Interface Pack. If you are working with a LoadRunner User Interface Pack, it
is recommended that you install it before running LoadRunner for the first time.

l Menus and toolbars. If you install a LoadRunner User Interface Pack after running LoadRunner
for the first time, the menus and toolbars may not get translated.

Workaround:

l Close LoadRunner and delete the following folder from the registry: HKEY_CURRENT_
USER\Software\<Folder Name>, where <Folder Name> is the drive on which you installed
LoadRunner.
For example, if LoadRunner is installed on the C drive, the registry folder name would be: HKEY_
CURRENT_USER\Software\C:

l Restart LoadRunner.
l Report Templates in Analysis. If you install a LoadRunner User Interface Pack after running

LoadRunner for the first time, the Report Templates in Analysis (Reports > Report Templates)
may not get translated.

Workaround:

l Close LoadRunner and copy the files from: <LoadRunner User Interface Pack CD
root>\Reporting to folder <LoadRunner installation folder>\bin\dat\Reporting.

l Restart LoadRunner.

Non-Localized LoadRunner on Foreign Language Operating Systems

l Language support. LoadRunner only supports English and the native language of the machine's
operating system. For example, if you are using Japanese Windows XP, you can work with
LoadRunner in Japanese and in English.

l Installation path. The path in which installation files for LoadRunner are located, and the path in
which LoadRunner is installed, can contain only English characters.

l Diagnostics add-in. To use the Diagnostics add-in with Controller on a computer with a non-
English operating system the Diagnostics_9.0_8.0_LR_Addin_QCCR1I52206 hotfix should be
installed. For further assistance, contact HP customer support.

l .NET Framework 3.5 failure. Installing LoadRunner on a localized machine may result in a
failure in the .NET Framework 3.5 installation process, and you will be asked to terminate the
installation. This happens because the .NET 3.5 Framework installation attempts to download the
Framework Language Pack but fails.

Workaround: Terminate the LoadRunner installation according to the Installation wizard's
instructions and invoke the LoadRunner installation again.

l Online Help. The search functionality may not function as expected for strings that contain
Chinese/Japanese characters (except Japanese full-width Katakana).

Workaround: Add a half-width space after each character in the search string.

l Online Help. For optimum performance of the online Help, you should install the latest JRE.
l Japanese characters in Web (HTTP/HTML) scripts. If you set the advanced recording option
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to specify the encoding of an application, and the application uses different character encoding for
different pages, then the recording log or script may display invalid Japanese characters. This does
not cause any errors in the script replay.

l Non-breaking spaces in Web protocols for Far Eastern languages. A non-breaking space
(&nbsp; &#160; &#xA0; `\xA0', etc.) cannot be represented in some Far Eastern locale character
sets (in which it is considered a lead byte). Instead, non-breaking spaces are converted to regular
spaces (` `, `\x20', etc.), both during script code generation and replay. This may cause replay
problems, such asmismatches in length due to eliminating multiple regular spaces.

Workaround: To work around this issue, either:

l Remove/add space(s) from/to the script so the comparison succeeds.
l Specify regular expressions to avoid the issue.
l Standalone installations. The installation interface of the VuGen and Analysis standalone are in

English and not localized.
l Flex AMF call properties. Multibyte symbols in Flex AMF call properties will be corrupted in the

script text view.
l ODBC protocol and Oracle-2T protocols.When recording a script in VuGen using the ODBC

or Oracle-2t protocols, if you stop the recording while the AUT is still open, VuGen may crash.
Workaround:

l Close LoadRunner.
l Open the file <LoadRunner installation folder>\dat\protocols\options\script\general.opt in

a text editor.
l Comment out the following line by adding a semicolon at the beginning of the line:
Option=DumpProcesses

So it looks like this:

;Option=DumpProcesses

l PDF report. In Analysis, a PDF report may be generated with unreadable characters if it contains
non-English characters.

Workaround: Before you generate the PDF file, change the font in the Report Template that you
are using.

l Select Reports > Report Templates.
l Select the template that you want to use.
l In the Detailed Report section, select the Format tab.
l For each UI element in the list, change the font to the desired font that supports the language in

which the report is written.
l Diagnostics add-in. Using the Diagnostics add-in with Controller on a computer with a non-

English operating system is not supported.
Workaround: Install the Diagnostics add-in with Controller on a computer with an English operating
system. The generated results can be viewed with a localized version of Analysis. For further
assistance, contact HP customer support.
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HP Software Support
You can visit the HP Software Support Web site at:

http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support that
HP Software offers.

HP Software online software support provides customer self-solve capabilities. It provides a fast and
efficient way to access interactive technical support tools needed to manage your business. As a
valued support customer, you can benefit by using the support site to:

l Search for knowledge documents of interest
l Submit and track support cases and enhancement requests
l Download software patches
l Manage support contracts
l Look up HP support contacts
l Review information about available services
l Enter into discussions with other software customers
l Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also
require a support contract. To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html

Legal Notices
Confidential computer software. Valid license from HP required for possession, use or copying.
Consistent with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software
Documentation, and Technical Data for Commercial Items are licensed to the U.S. Government
under vendor's standard commercial license.

The only warranties for HP products and services are set forth in the express warranty statements
accompanying such products and services. Nothing herein should be construed as constituting an
additional warranty. HP shall not be liable for technical or editorial errors or omissions contained
herein.

The information contained herein is subject to change without notice.

Trademark Notices

Java is a registered trademark of Oracle and/or its affiliates.

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.

Oracle® is a registered US trademark of Oracle Corporation, Redwood City, California.

UNIX® is a registered trademark of The Open Group.

© Copyright 2012 Hewlett-Packard Development Company, L.P.
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